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In recent years, hybrid devices that consist of a living cell or tissue component integrated with a synthetic mechanical backbone have been
developed. These devices, called biorobots, are powered solely by the force generated from the contractile activity of the living component

and, due to their many inherent advantages, could be an alternative to conventional fully artificial robots. Here, we describe the methods

to seed and characterize a biological actuator and a biorobot that was designed, fabricated, and functionalized in the first part of this two-

part article. Fabricated biological actuator and biorobot devices composed of a polydimethylsiloxane (PDMS) base and a thin film cantilever
were functionalized for cell attachment with fibronectin. Following functionalization, neonatal rat cardiomyocytes were seeded onto the PDMS
cantilever arm at a high density, resulting in a confluent cell sheet. The devices were imaged every day and the movement of the cantilever arms
was analyzed. On the second day after seeding, we observed the bending of the cantilever arms due to the forces exerted by the cells during
spontaneous contractions. Upon quantitative analysis of the cantilever bending, a gradual increase in the surface stress exerted by the cells as
they matured over time was observed. Likewise, we observed movement of the biorobot due to the actuation of the PDMS cantilever arm, which
acted as a fin. Upon quantification of the swimming profiles of the devices, various propulsion modes were observed, which were influenced

by the resting angle of the fin. The direction of motion and the beating frequency were also determined by the resting angle of the fin, and a
maximum swim velocity of 142 um/s was observed. In this manuscript, we describe the procedure for populating the fabricated devices with
cardiomyocytes, as well as for the assessment of the biological actuator and biorobot activity.

Video Link

The video component of this article can be found at https://www.jove.com/video/55643/

Introduction

Biorobots are devices based on living cells that are incorporated within a mechanical backbone that is usually composed of soft, elastic
materials, such as PDMS or hydrogels The cells undergo rhythmic contractions, either spontaneously or in response to stimuli, and thus
function as an actuator. The power generated from cell contraction drives various biorobots. Mammalian heart cells (cardiomyocytes) and
skeletal muscle cells are often used for blorobot actuation due to their contractlle properties. Aside from cardiomyocyte and skeletal muscle cells,
other cell types, such as insect muscle tissues? and explanted muscle tissues®, have been used. Insect muscle tissues enable the operation of
biological actuators at room temperature.

The function and performance of a biorobot are chiefly determined by the strength and consistency of the biological actuator (i.e. muscle cells),
while the mechanical backbone structure primarily determines the mechanisms of locomotion, stability, and power. Since these devices are solely
driven by forces generated by cells, there are no chemical pollutants or operating noises. Therefore, they form an energy-efficient alternatlve to
other conventional robots. Various literature sources have discussed the different methods to integrate living cells and tissues into biorobots 145
Advances in microfabrication and tissue engineering techniques have enabled the development of biorobots that can walk, grip, swim, or

pump % In general, cells are cultured directly onto the mechanical (polymeric) backbone as a confluent cell sheet or they are molded into 3-
dimensional actuating structures within scaffolds such as rings and strips. Most often, biorobots are fabricated using cardiomyocyte sheets®’ , as
these cells have an innate ability to exhibit spontaneous contraction without external stimuli. On the other hand, reports on skeletal muscle ceII
sheets are limited due to their need for stimuli to initiate contractions in vitro in order to initiate membrane depolarizations.

This protocol first describes how to seed cardiomyocytes on a functionalized biological actuator made of a thin PDMS cantilever. It then
describes in detail the seeding and analysis of the swimming profiles. The cantilever is functionalized with a cell adhesive protein such as
fibronectin and is seeded confluently with cardiomyocytes. As the cells seeded on the device contract, they cause the cantilever to bend and thus
to act as an actuator. Over time, as the cells mature, we trace the changes in surface stress on the device by analyzing videos of the cantilever
bending. The biological actuator developed here can be used to determine the contractile properties of any cell type, such as the fibroblasts or
induced pluripotent stems cells, as they undergo differentiation.
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Much of the earlier research on biorobots has been focused on developing biological actuators, while optimization of the biorobot architecture
and functional capabilities were largely neglected. Recently, a few studies have demonstrated the implementation of swimming modes in
biorobots that are inspired by nature. For example, swimming biorobots with flagella-based motion®, jellyfish propulsiong, and bio-hybrid rays4
have been engineered. Unlike other works in literature, here we focus on varying the properties of the mechanical backbone to create a self-
stabilizing structure. The biorobot developed in this study is capable of maintaining a constant pitch, roll, and immersion depth as it swims. These
parameters can be modified by varying the thickness of each base composite. The fabrication steps involved in developing the PDMS actuator,
the submergible biorobot, and the functionalization of the device are described in detail in Part 1 of this two-part article, as well as in our recent
work”.The technique developed here can pave the way for the development of novel, highly efficient biorobots for various applications, such as
cargo delivery.

The isolation process followed in this study is similar to the process described in an earlier workw, as well as in recently published work’.

The microfabrication methods used for fabricating the PDMS actuators and biorobot devices are described in detail in Part 1 of this two-part
manuscript. The protocol section of this manuscript describes the steps involved in seeding cardiomyocytes onto the fabricated PDMS actuator
and the biorobot following their functionalization with cell adhesive proteins.

All procedures described here have been carried out using an approved protocol and in accordance with the regulations of the Institutional
Animal Care and Use Committee of the University of Notre Dame.

1. Cell Seeding and Culture

Before starting, prepare the required items: a small funnel, pipettes, and warm Dulbecco's Modified Eagle Medium (DMEM) supplemented
with 10% Fetal Bovine Serum (FBS) and 1% penicillin antibiotic (DMEM complete).
Take T-25 flasks along with the functionalized device (biological actuator or the biorobot) within it. Refer to section 4 of Part 1 of this two-part
manuscript for details regarding device preparation, functionalization, and storage prior to cell seeding.
Prepare a funnel, which can be made by rolling a small, square plastic sheet. Place it over the biological actuator or biorobot inside the T-25
flask. Adjust the diameter of the wider end to fit the entire device and the height so that it fits snugly when the top of the flask is tightened.
1. For the biorobots, use a magnet to hold the device in place at the bottom of the flask throughout the seeding process.
Note: Here, a single neodymium disc magnet (1.26" in diameter) was used, but any magnet of similar size and strength can also be
used to hold down the biorobot with the magnetic nickel-PDMS composite base.
2. UV sterilize the plastic sheet for at least 30 min prior usage.

Ensure that there is not a large gap between the base of the funnel and the flask.

Resuspend the cardiomyocytes in DMEM complete at a density of 1.6 x 10" cells/mL and slowly drop 400 pL of suspension onto the device
through the funnel. Use a hemocytometer or any other cell counter to determine the number of cells obtained.

Slowly move the system back into the incubator without disturbing the device and the funnel within. Culture for 24 h at 37 °C.

After the incubation period, slowly remove the funnel, gently wash the sample with PBS, and refill the flask with 10 mL of fresh DMEM
complete.

Note: For the biorobots, remove the magnet so that the device is afloat.

2. Biochemical Characterization

1.

Calcium flux assay
Note: The calcium flux assay is carried out to assess cell interconnectivity. The procedure for loading the cells with the fluorescent, calcium
ion-specific dye follows the process described in a previously established protocol”.

1. First, prepare the required materials, calcium fluo-4-acetomethyl (AM) ester, nonionic surfactant polyol (see the Table of Materials),
and Tyrode's salt solution.

2. Using long tweezers, gently transfer the device from the culture flask to a 35-mm Petri dish with 2 mL of Tyrode's salt solution.

3. In a separate centrifuge tube, take 1 mL of warm Tyrode's solution (warmed to 37 °C) and add 3-5 pL of stock calcium fluo-4 AM dye
(working concentration: 3-5 uM) and an equal part of nonionic surfactant polyol (working concentration: 0.2 %). Replace the sample
solution with warm Tyrode's solution supplemented with the calcium indicator dye, fluo-4, and 0.2% nonionic surfactant. Incubate for 25
- 30 min at 37 °C.

4. Remove the dye solution and gently wash the sample with fresh Tyrode's solution. Re-incubate the sample in 2 mL of fresh DMEM
complete for another 30 min at 37 °C prior to imaging.

Note: The results of this assay and related video are provided in the previously published work”.

Immunofluorescence
Note: The double immunostaining of all the samples was performed following previously established protocol12.

1. First, prepare 10% goat serum (GS) in phosphate-buffered saline solution (PBS), 4% paraformaldehyde (PFA) in diH,0, 0.1% cell lyse
detergent (see the Table of Materials) in PBS, primary antibodies (anti-mouse monoclonal antibody cardiac troponin-l and anti-rabbit
monoclonal antibody connexins-43), secondary antibodies (Alexa 594 conjugate and goat anti-mouse IgG (H+L) Alexa 488 conjugate),
and DAPI.

Caution: Paraformaldehyde is carcinogenic.

2. Remove the sample of interest from the flask and gently wash it twice with PBS. Refer to section 4 in Part 1 of this two-part manuscript

for details regarding sample preparation and functionalization.
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3. Add a droplet of PBS onto a small coverslip (diameter: 12 mm or 15 mm). Gently hold the base of the device with tweezers and cut
the thin PDMS arms (cantilever, Figure 1) using scissors from the end where it connects to the top of the base. Transfer the cantilever
arms onto the droplet with the cell-adhered side facing upward. The PBS droplet will prevent the cells from drying.

4. Fix the samples with 4% PFA and perform double immunostaining of the samples, as described previously12.

5. After immunostaining, mount the samples onto a clean glass slide using anti-fade mounting reagent and set aside, undisturbed, in the
dark for 24 h.

6. Repeat the procedure for all samples.

Note: The results of this assay and the related images are discussed in depth in the previously published work”.

3. Imaging

1. Place the T-25 flask upright in a CO, incubator and prepare the imaging system inside the incubator. Record the device using a camera (see
the Table of Materials) with a zoom lens (see the Table of Materials). For a light source, use a strip of LED lights.
Note: A strip of white-light LEDs was used here, but any normal LEDs will also work.
2. Connect the camera to an operating system and open the camera-specific software (see the Table of Materials). Click on the camera image
underneath the "File" tab, in the top panel, to open all camera options, and choose the correct camera.
3. Choose "live" from the list of tabs on the top panel within the software.
4. Manually bring the image into focus by adjusting the lens dial. Select "Crop to region of interest (ROI)" from the top panel. Then, manually
draw a rectangle in the video frame, enclosing the biological actuator device and the cantilever arms, to mark the ROI.
Note: Choosing an appropriate ROl minimizes the size of the image files.
1. In the case of biorobots, capture the whole screen in order to record the swimming motion of the device.
NOTE: There is no need to draw an ROI for the biorobots

5. Before starting the recording, select "Camera Settings" from one of the tabs in the top panel on the screen. Set the frame rate by adjusting
the exposure and pixel ratio of the live image by sliding the bar for each or by manually entering the values. Set the frame rates to about 30 +
2 fps.
Note: Changing the exposure and pixel ratio changes the brightness and contrast of the live image.

6. Click the "Record" button from the top panel in the software to start recording the videos of the actuators with 1,000 x 1,000 pixel resolution
for precisely 30 s. Repeat the process for all samples.

4. Image Analysis of the Biological Actuators on a Stationary Base

1. Analyze the images using a programming software (e.g., Matlab) running the custom script. See the Table of Materials and the
Supplemental File for further details.
Note: The script displays each frame of the recorded videos, receives the user's mouse input to record the coordination of the points of the
cantilever on the images, calculates the diameter and center of the circle that passes the inputted points via least square fitting, and exports
all of the inputted and calculated data for further use.

1. Open the programming software by clicking on the icon. Click "File" -> "Open" from the menu bar at the top and select the .m script file
for image analysis. Ensure that recorded TIFF images are in the same folder as the .m file. Click "Run" to run the script.

Note: An interactive display will pop up for altering.

2. Press "play" to start the actual program. Click the "open" button and locate the TIFF file that is going to be analyzed.

3. Click the "base" button and then click on the point where the cantilever attaches to the base at the top; hit enter. This will place a
square marker on the image for each frame to denote the location of the cantilever base.

4. Click the "Scale" button and then manually click on one edge of the glass bead. Bring the mouse pointer to the opposite side of the
glass bead and press "Enter."

Note: This should draw a line that measures the diameter of the glass bead. Since the glass bead is 3 mm in diameter, this will relate 3
mm to the pixels displayed.

5. Click the "Analyze" button. Click along the cantilever at a short distance from the first square marker that represents the cantilever
base.

6. Click the “Analyze” button. Then, click along the cantilever at a short distance from the first square marker that represents the
cantilever base. Continue to click along the cantilever, including the tip, and press enter when done. This will place an “x” on each point
clicked on the cantilever.

Note: Based on the coordination of the square marker and on the x markers, the center and diameter of a circle will be calculated using
a least square fitting function (refer to the attached supplemental file for the script used). The circle, which passes the x markers and
the square maker, will be superimposed on the image automatically.

7. Check if the superimposed circle correctly traces the cantilever profile.

Note: When the cantilever is very flat, it is hard to judge if the cantilever profile is traced correctly. Refer to Figure 3.

8. Click the "next frame" button. This will switch to the next frame in the TIFF file. The base and scale are already set from the previous
step.

9. Repeat steps 4.1.5 through 4.1.7 until all of the frames in the TIFF file have been completed. Once all frames have been processed,
click the "Export" button.

Note: This will make a spreadsheet file with the TIFF file name for the cantilever that was just analyzed. Edit the filename to include
which side (left or right) of the cantilever was analyzed.

2. Calculating stress in the spreadsheet.
1. Calculate the surface stress, "0," on the cantilever using the following equation:
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where E, R, v, and h are Young's modulus, the radius of curvature, Poisson's ratio, and the cantilever thickness, respectively.

Note: The thickness of the cantilever can be altered to change the sensitivity. In this study, the values were as follows: E = 750 kPa, v =
0.49, and h = 25 um ™",

Calculate the surface stress using the equation in step 4.2.1. Open the .xls spreadsheet file. Note that the output has multiple columns
showing first the x and y coordinates of base and circle and then the radius of curvature. Calculate the x and y coordinates of each
point clicked based on these.

Note: Plotting the stresses over the time-lapse image frames shows changes in the force exerted on the cantilever over time. The
troughs show the stress on the cantilever during the relaxation of the cardiomyocytes or the static stress exerted on the cantilever due
to cell traction forces. The peaks show the dynamic stress on the cantilever, which was exerted by the beating of the cardiomyocytes.
This value corresponds to the maximum amount of force generated by the contraction of the cardiomyocytes.

5. Analysis of Swimming Biorobots

1.

Record the position of the biorobot using image analysis software.
Note: See the Materials list for the software used in this section.

1.

2.

5.
6.

7.

Open the image analysis software (e.g., ImageJ). Press "File" and "Open" and select the swimming biorobot video file. Click "OK" and
let the program load the file. Open the spreadsheet software.

In the loaded biorobot video, find a reference of known dimensions (e.g., the glass bead 3 mm in diameter that was embedded in the
biological actuator).

Note: Any object with known dimension will work. This will determine the pixel-to-length ratios in each video.

Use the "Straight" tool to draw a line across the glass bead. Click "Analyze" and select "Set scale." Set the "Known distance" field to
"3,000 um" and click "Ok."

Note: This will set the x and y coordinates to micrometers.

Choose a point on the device that does not wobble between frames to act as a marker.

Note: It is recommend to choose a corner of the base.

Point to the selected point in 5.1.4 on the first frame. Record the x and y coordinates on the spreadsheet.

Switch back to the image analysis software window and press the right arrow key to change to the next frame. Point to the marker
again (from step 5.1.4) and record the x and y coordinates on the spreadsheet.

Repeat step 5.1.6 for all frames.

2. Calculate the swimming parameters of the biorobot using the spreadsheet of coordinates’.

1.
2.
3.

4.
5.
6

Calculate the period between frames from the known frame rate of each video.

Calculate the change in the x and y coordinates between frames to find the distance moved, including the total distance.

Calculate the amplitude of contraction from the maximum change along the y-axis. Determine the beating frequency for each biorobot
from the inverse of the period between two contractions.

Calculate the swimming speed of each device from the total time and distance moved in the x-direction.

Repeat step 5.2 for each biorobot video that was analyzed.

Normalize each measured parameter.

Note: Normalize all the values to better visualize the differences. This protocol demonstrates normalization with respect to a horizontal
mode biorobot with low-frequency contractions (horizontal LF) (Figure 4)7.

6. Analysis of Protein Expression

Note: The mounted samples prepared in steps 2.2.4 and 2.2.5 were imaged using a confocal microscope. Images were acquired at 20X, 40X,
and 60X magnification sequentially in three channels simultaneously: 460 nm, 488 nm, and 594 nm. A set of 5 images were captured at 40X
magnification, from different positions for each sample, and each channel was saved as an individual .TIFF file. The exposure setting was
determined by the magnification of the objective used and was set constant for all the captures at that magnification.

1.
2.
3

4.

Open the image analysis software and select "File" -> "Open" to load the images.

Draw a rectangular polygon on the image frame to mark the ROI. Select "Analyze" -> "Measure" to measure the mean fluorescent intensity.
Repeat step 6.2 to collect intensity measurements from all the samples and calculate the respective mean intensity for each condition.
Note: Here, a different condition refers to different time points, as in, day 1, day 2, and up to day 6.

Export the results on a spreadsheet for further statistical analysis and for the production of data plots.

Representative Results

The biological actuator made of a thin PDMS cantilever (25 pm in thickness) and cardiomyocytes constitutes the core of the swimming biorobot,
as shown in the schematic and screenshot of the devices in Figure 1. The cells start to exhibit contractions after 24 h in culture, and bending of
the cantilever arms was observed by day 2. The side profile of the device was recorded every day, and the surface stress was quantified from
the bending of the cantilever arms using a customized image analysis script7. The static and dynamic stresses were extracted from the surface
stress on each day (Figure 2a). Note that static stress (cell traction force) is the contractile stress the cells exhibit on the surface at their resting
state and dynamic stress (cell contraction force) is the stress generated by the cells at maximum contraction.
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The biological actuator continued to exhibit spontaneous contractions for up to 10 d, and data was collected for the first 6 days. As the cells
matured in culture, a gradual increase in static and dynamic stress was observed over time (Figure 2a). There was a large standard deviation
in the measurement of forces due to differences in cell maturation between different samples. The cells exhibited a maximum cell traction force
of 50 mN/m and a maximum contraction force of about 165 mN/m on day 6. Analysis of all individual data for multiple samples showed a strong
positive correlation between the static and dynamic stresses, as both showed an increase over time.

In order to quantify the maturation of the cardiomyocytes over time, the expression levels of some of the structural and functional cardiomyocyte
proteins, such as cardiac troponin |, gap junction protein connexin-43, and actin filaments, were calculated. As seen in Figure 2b, a steady
increase in intensity measurements over time were observed, correspondmg to the expression of the respective proteins. This increase in protein
expression confirms the maturation of the cells (cardiac troponin I) cell growth and spread (i.e. increase in actin expression), and an increase
in cell interconnectivity (i.e. increase in the number of gap Junctlons).

The static and dynamic stresses plotted in Figure 2a were quantified using a customized computer script, as described in the earlier section.
Once the recorded images of the biological actuator were loaded into the system, the script allowed for the tracking of the movement of the
cantilever arm with the help of manually assigned markers, as shown in Figure 3. A gradual increase in the bending angle of the cantilever arms
was observed over time in culture, which corresponded to the increase in dynamic contraction and static ceII traction force exhibited by the cells’.
The results of the calcium flux assay and the related video are provided in the previously published work”.

The biorobots exhibited spontaneous contractions on day 2 after cell seeding and were able to actively swim horizontally for up to 10 d. Due

to the force balance between the weight of the biorobot and the buoyancy, the device maintained a stable position at the air/medium interface.
Displacement or movement of the biorobots was driven by the synchronous contractions of the cardiomyocytes, which caused the bending of the
thin cantilever arms and functioned as an actuator. It was observed that the velocity of the biorobots and the distance moved with each stroke
decreased after 6 d in culture. Since the muscle cells used in this study were primary cardiomyocytes |so|ated from neonatal rats, the seeded

cell population also contained other cell types, such as cardiac fibroblasts, which are highly prollferatlve . As the cardiac fibroblasts proliferate
and spread over time in culture, they can suppress the contractility of cardlomyocytes The result is consistent with other studies that have shown
that the activity of primary cells inherently declines after the first week in culture™. In future research, the cell culture could be treated with anti-
mitogen agents to block non-myocyte proliferation to increase the lifetime of the biorobots.

We observed that the resting angle of the cantilever arm after the fabrication determined the swimming profile of the biorobots, providing either
a horizontal or vertical mode to the swimming profiles of the biorobots. Here, "horlzontal" and "vertical" refer to the resting angle of the cantilever
with respect to a horizontal axis and do not refer to the direction of swimming motion”. The vertical biorobots had a resting angle of about 110°
and contracted at an angle of 90°, while the horizontal-mode biorobots had a resting angle of about 45° and contracted about the horizontal axis
(0°). Also, we observed a wide range of beating frequencies across all of the samples and broadly classified them as either a high-frequency
(HF) or low-frequency (LF) mode. Figure 4 compares the velocity, beating frequency, and distance traveled for a single stroke for three main
types of biorobots: horizontal HF, horizontal LF, and vertical mode. The horizontal HF biorobots exhibited an average beating frequency of 1.6

+ 0.417 Hz, while the horizontal LF biorobots maintained a steady 1.09 + 0.134 Hz. Although the vertical biorobots exhibited only 0.86 + 0.07
Hz, they exhibited a higher swim velocity of 142 um/s and exhibited the greatest distance traveled at 160 + 642 ym. On the other hand, the
horizontal LF traveled about 48 + 21.2 ym with each stroke at a speed of 67.3 um/s, while the horizontal HF biorobot had a velocity of 84.4 ym/s
and covered a distance of 61.5 + 17.7 um per stroke.

A

cCardiorrwccvtes
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Microbaloon PDMS

composite  ——®
POMS base - —
Glass microbead Nickel P.DMS

composite

At rest At contraction

Cardiomy

2L

4—PDMS base

ead
2 mm

At contraction

Figure 1: Biological Actuator and Biorobot. (A) Schematic of the biological actuator seeded with a confluent cell sheet in relaxed and
contracted state (top panel) and a screenshot of the device in culture (bottom panel). As shown in the figure, the biological actuator is composed
of a thin, functionalized PDMS cantilever (25 uym thick) seeded with a sheet of cardiomyocytes. This actuator forms the core of the swimming
biorobot, also as shown. (B) Schematic of a single-arm biorobot seeded with a confluent cell sheet (top panel) and a screenshot of the device in
culture (bottom panel). Please click here to view a larger version of this figure.
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Figure 2: Biomechanical Analysis of the Cardiomyocytes. (A) The dynamic contraction force and static cell traction force increased as the
cardiomyocytes matured; sample size = 6 for each parameter. The dynamic and static stress expressed by the cells increased over time as the
cells matured and developed in culture. A maximum static force of 50 mN/m and a dynamic contraction force of 165 mN/m were observed on day
6. (B) Quantification of the fluorescence intensity for the protein markers cardiac troponin-I, connexins-43, and actin; sample size = 4 for each
parameter. The fluorescence signal for all three markers increased throughout the culture, suggesting an increase in the expression of these
functional proteins over time in culture. The error bars in (A) and (B) represent the standard deviation for each parameter quantified. Please click
here to view a larger version of this figure.

011815 _cantilever! avi
Open File
Frame 1751

<<Frame | Frame== Analyze Sel Base ]
( Set Scale l SAVE
FIT. 32

DIST: 23.2

LOAD_PTS

Export

Figure 3: Quantification of ROC: Radius of Curvature (ROC) Calculations using a Customized Image Analysis Script. The ROC found
during a contraction is illustrated in the figure. Multiple points are manually picked along the cantilever, shown as a small green "X." Once
entered for calculation, a best-fit circle is drawn for the points provided, as shown by the green circle going through the cantilever. Please click
here to view a larger version of this figure.
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Figure 4: Comparison of the Average Swim Velocity, Beating Frequency, and Distance Moved/Stroke for 3 Biorobots with Different
Swimming Profiles: Horizontal Low Frequency (Horizontal LF), Horizontal High Frequency (Horizontal HF), and Vertical. The
measurements are normalized to the value of horizontal LF. The error bars represent the relative standard deviation for each parameter
quantified. The horizontal LF and HF each had a cantilever arm with a resting angle along the horizontal axis and displayed beating frequencies
of 1.09 + 0.134 Hz and 1.59 + 0.417 Hz and swim velocities of 67.3 um/s and 84.4 um/s, respectively. The vertical biorobot exhibited a beating
frequency of 0.862 + 0.075 Hz and an average swim velocity of 142 um/s. Please click here to view a larger version of this figure.

The procedure outlined here describes a successful seeding method for PDMS-based actuators and biorobots, which facilitates the attachment
of cardiomyocytes. Furthermore, the process of image acquisition and the subsequent analysis that characterizes the behavior of the cells and
the performance of the devices was described.

We observed spontaneous contraction of cells on the cantilever arms after 24 h; the intensity of contractions continued to increase steadily over
time and reached a maximum on day 6, after which the intensity decreased slowly. Although the cantilever arms of the biological actuator were
only 4 mm long, large deflections up to 2.5 mm were observed, especially after 6 days in culture. The low Young's modulus (750 kPa) and ultra-
low thickness of the cantilever (25 um) allowed for such large deflections, which resulted in the strong propulsion of the biorobots. In order to
assess the mechanical characteristics of these cells, we quantified the cell contraction and traction forces generated on each day. Thin film
cantilevers have been used for measuring contractility and mechanical stress induced by cardiomyocytes or other muscle cells™".

The measured maximum dynamic contraction force of 165 mN/m in this study is comparable to the Iiterature13, where cells seeded on a hydrogel
cantilever exhibited a systolic stress of about 82.8 + 22.4 mN/m. The measured forces and the increase in stress over time were relatable to the
maturation of the cells seeded on the device, as seen from the corresponding increase in contractile and cytoskeletal protein expression. The
electromechanical coupling also increased over time, as seen from an increase in expression of the gap junction protein connexins-43.

The biorobot device developed here falls in the category of ostraciiform swimmers'®, where the propulsion is provided by the wagging of a tail
and deflection is limited to the caudal fin. The maximum swim velocity of 142 ym/s, exhibited by the vertical mode biorobot, is between the
measured values of other popular swimming biorobots in the literature, which are flagella-based biorobots with speeds of about 9.7 um/s6 and
jet-propulsion mode devices with speeds of 6 - 10 mm/s”.

In recent years, many biological machines or biorobots have been developed using soft, elastic materials, such as PDMS and hydrogels, and
are seeded with contractile muscle cells. Walking and swimming biorobots have garnered increased focus as an alternative to traditional robots
due to their potential to function as energy-efficient, agile robots with self-repair potential1’5. Unlike other biorobots in the literature, the biorobot
developed in this study can maintain its own pitch, roll, and immersion depth7. However, the longevity of the cardiac cells used here is one of the
biggest limitations, as the life span is restricted to 10 d. To overcome this limitation, contractile cell types from other species may be used to drive
the device, rather than mammalian-derived cells. For example, various works by Akiyama et al. have explored the use of contractile insect wing
cells for actuation, as they have longer life spans and can survive at atmospheric temperaturez.

Currently, the cells are cultured isotropically on the cantilever surface, which limits the net contractile force generated. In future studies, one

of the possible modifications that can be included will be to incorporate micropatterns on the cantilevers to attain anisotropic alignment of

the seeded cells®. Also, electrodes could be inserted for electrical stimulation to enhance the force generated by the cells*. With continued
advancement in technology and manufacturing techniques, these devices can pave the way for the development of novel biological machines
with diverse applications, such as cargo delivery. For instance, the base of the biorobot developed here can be easily modified to carry small
packages (i.e. cargo)7. Therefore, in this work, we have provided an alternate approach to develop a biorobot, focusing on varying the properties
of the mechanical backbone to create a self-stabilizing structure. Moreover, the biological actuator developed here can be used to determine the
contractile stress of other cell types, such as fibroblasts and induced pluripotent stem cells.
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